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Einleitung 

Integration von Kontaktmanagement und Kommunikationssoftware 

Die Adress- und Kontaktmanagement Software combit Relationship Manager und die Messaging & 

Collaboration Software Lösung Lotus Notes ergänzen sich im Bereich Bürokommunikation optimal. Die 

Ursache liegt im offenen Schnittstellenkonzept des Relationship Manager begründet, das eine vielfältige 

Anbindung von Fremdsoftware ermöglicht. 

 

Wie wichtig die Integration einer Messaging & Collaboration Lösung mit einer Adress- und 

Kontaktmanagement Software ist, liegt auf der Hand: Beide Systeme dienen der optimalen 

Kundenkommunikation und müssen daher bestens zusammen arbeiten. Genau dies leisten diese beiden 

Software-Produkte. 

Aufgabenstellungen aus Anwendersicht 

Typische Aufgabenstellungen im Bereich Kundenkommunikation sind 

 Versenden von Einzel-eMails 
 Versenden von personalisierten Serien-eMailings 

 
 Hinterlegung der Kommunikationsvorgänge beim Kundendatensatz 
 Pflege einer Kundenkontakthistorie 

 

Erweiterte Aufgabenstellungen könnten sein 

 Übernahme bestehender Adressen aus der Messaging & Collaboration Software Lösung 
 Übergabe von Kundenadressen an die Messaging & Collaboration Software Lösung 

Lösung durch Integration zweier leistungsfähiger Produkte 

Alle diese Vorgänge können mit Lotus Notes und dem combit Relationship Manager gelöst werden. Dabei 

übernimmt der combit Relationship Manager den kompletten Kundenadress-relevanten Teil wie die 

Bereitstellung der Adressinformation (Name, Anschrift, Faxnummer, eMail-Adresse etc.) gegenüber Lotus 

Notes. 

 

Nachfolgend soll nun dargelegt werden, wie dies erreicht werden kann. 

Versenden von eMails 

Konfiguration der Schnittstellen 

Einrichtung im combit Relationship Manager 

Aktivieren Sie im combit Relationship Manager unter Konfiguration > Allgemein auf der Lasche Mailversand 

die Option Simple MAPI. Diese Option ist standardmäßig bereits aktiviert. 

Einrichtung von Lotus Notes als Standard eMail-Programm 

In der Windows Systemsteuerung finden Sie unter Internetoptionen die Einstellung für das Standard eMail-

Programm. Bitte wählen Sie in diesem Dialog Lotus Notes aus. 

http://www.lotus.com/world/germany.nsf/83e9ca0f5fa77f91802569830067011c/846193c5779aeb71c1256d1200570264?OpenDocument
http://www.lotus.com/world/germany.nsf/83e9ca0f5fa77f91802569830067011c/846193c5779aeb71c1256d1200570264?OpenDocument
http://www.lotus.com/world/germany.nsf/83e9ca0f5fa77f91802569830067011c/846193c5779aeb71c1256d1200570264?OpenDocument
http://www.lotus.com/world/germany.nsf/83e9ca0f5fa77f91802569830067011c/846193c5779aeb71c1256d1200570264?OpenDocument
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[Abbildung: Konfiguration des Programms] 

 

Diese Einstellungen sind besonders dann wichtig, wenn Sie auf Ihrem System zusätzlich Outlook oder 

Outlook Express installiert haben. Wenn Sie noch ein weiteres eMail-Programm verwenden, müssen Sie 

sicherstellen, dass Lotus Notes als Standard MAPI Client eingerichtet ist. 

Hinweis: Für die Verwendung des Simple MAPI Mailversands mit dem combit Relationship 
Manager (Ausgabe > Einzel/Serien-eMail) und Lotus Notes 8.5 ist mindestens die Version 5.008 
notwendig! 

Bekannte Einschränkungen 

Beim Versenden von Einzel- und Serien-eMails aus dem combit Relationship Manager werden die eMails nicht 

direkt versandt, sondern es wird für jede eMail ein Fenster erzeugt, welches geöffnet bleibt. Die angelegten 

eMails müssen manuell versendet werden. Dies ist eine Eigenheit von Lotus Notes. 

 

Damit Sie wie gewohnt mit dem eMail-Versand aus dem combit Relationship Manager heraus arbeiten 

können, finden Sie im Kapitel "Mailanbindung" mehrere Scripts, die den eMail-Versand für Sie 

automatisieren. 
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Import/Export von Adressen 

Import für Kontakte 

In Lotus Notes finden Sie den Import, wenn Sie sich in der Kontaktdatenbank befinden, unter dem 

Menüpunkt File > Import. 

 

Lotus Notes bietet folgende Importmöglichkeiten: 

 
 Calendar File (.ics) 
 Structured Text 
 Tabular Text 

Export für Kontakte 

Sie finden den Exportdialog in Lotus Notes, wenn Sie sich in der Kontaktdatenbank befinden, unter dem 

Menüpunkt File > Export. 

 

Lotus Notes bietet die folgenden Exportformate an: 

 
 Calendar File (.ics) 
 Comma Separated Value 
 Structured Text 
 Tabular Text 

Zusatzprodukte zu Lotus Notes 

Mit Hilfe von kostenpflichtigen/kostenlosen Zusatzprogrammen zu Lotus Notes können Sie den Import bzw. 

Export von/aus dem combit Relationship Manager in Lotus Notes realisieren. Wählen Sie dazu ein Format 

aus, welches der Import Assistent des combit Relationship Manager unterstützt (z.B. Textdatei mit variablem 

Spaltenformat). 

Anbieter von Zusatzprodukten 

 
 InfoServ AG (http://www.infoserv.de) 
 Kim Beros Consulting (http://www.lotus-notes-export.com) 
 SWING Software (http://www.swingsoftware.com) 

 

Falls Sie Fragen zu den jeweiligen Produkten der obigen Anbieter haben, wenden Sie sich bitte direkt an 

diese.  

Zugriff auf die Adressdaten per LDAP 

Einleitung 

Mit Hilfe des mitgelieferten combit LDAP-Server besteht die Möglichkeit, auf die Adressdaten des combit 

Relationship Managers in Lotus Notes zugreifen. 

Voraussetzung hierfür ist die richtige Konfiguration des combit LDAP-Servers. 

http://www.lotus-notes-export.com/
http://www.swingsoftware.com/
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Die Konfiguration des combit LDAP-Server finden Sie im gleichnamigen combit Relationship Manager 

Handbuchkapitel. 

Konfiguration in Lotus Notes 

Um auf den combit LDAP-Server aus Lotus Notes heraus zugreifen zu können, müssen Sie zunächst einen 

'Account' in Lotus Notes anlegen. Gehen Sie dazu auf den Menüpunkt File > Preferences > Accounts. Wählen 

Sie anschließend New Account > LDAP. Im folgenden Dialog geben Sie die untenstehenden Daten ein: 

 

 

 [Abbildung: Account-Erstellung in Lotus Notes] 

 

Der 'Account Name' kann beliebig gewählt werden. Der 'Server' ist hier wie oben einzutragen. Beachten Sie 

bitte, dass die Verwendung von 'localhost' nicht funktioniert. Als Protokoll muss 'LDAP' ausgewählt werden. 

 

Klappen Sie nun die 'Advanced properties' auf und tragen Sie die Werte, angepasst an Ihre Referenzlösung, 

wie auf dem nachfolgenden Screenshot ein. 

app = cRM 

project = Name des cRM Projektes 

view = Ansicht im cRM für die Suche  

 

 

[Abbildung: Erweiterte Einstellungen] 
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Nach Abschluss der Eingaben müssen Sie nun nur noch den angelegten Account über OK  speichern. 

Suche von Adressdaten 

Starten Sie zunächst den combit LDAP-Server. Nun öffnen Sie in Lotus Notes die Personensuche mit Hilfe der 

Navigation-Toolbar. Klicken Sie dort auf die Dropdown-Schaltfläche Search und wählen Sie den Punkt 

Advanced > Find People aus der Liste. 

 

 

[Abbildung: Suche in Lotus Notes] 

 

 

Wählen Sie im nun geöffneten Suchdialog als Adressbuch den 'combit LDAP-Server' aus und starten Sie Ihre 

Suche. 
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[Abbildung: Adresssuche per LDAP in Lotus Notes] 

 

Für weitere Informationen zur Personensuche in Lotus Notes konsultieren Sie bitte die Lotus Notes Online 

Hilfe bzw. das Handbuch. 

Verfügbare programmierte Anbindungen 

Einleitung 

Für die Anbindung an den combit Relationship Manager wurden für Lotus Notes und den combit Relationship 

Manager einige Scripts erstellt. In Lotus Notes wurden diese mit Hilfe der integrierten Scriptsprache 

LotusScript realisiert. Für den combit Relationship Manager wurden VBScripts für die verschiedenen 

Aufgaben erstellt. 

Was ist ein LotusScript Agent? 

Mit Hilfe von so genannten Agents können Sie in Lotus Notes für wiederkehrende Aufgaben Aktionen 

definieren. Dafür stehen Ihnen in Lotus Notes unter anderem die Scriptsprache LotusScript zur Verfügung. 

Die erstellten Agents können unter dem Menüpunkt Actions in der jeweiligen Datenbank aufgerufen werden, 

wenn Sie die Auswahl Action menu selection auswählen. 

Weitere Informationen zur LotusScript Sprache finden Sie auf der Lotus-Homepage (http://www.lotus.com). 

Anlegen eines LotusScript Agent 

Damit Sie einen Agent anlegen können, müssen Sie die Datenbank zuerst öffnen, für die Sie eine Aktion 

definieren möchten (z.B. Mailversand). Nachdem Sie die Datenbank geöffnet haben, können Sie unter dem 

Menüpunkt Create > Agent... einen neuen Agent erstellen. In dem Agent Properties Fenster, welches sich 

nun öffnet, können Sie den Namen des Agents, eine Beschreibung und die Aktivität des Agents (unter 

Runtime) festlegen (siehe Abbildung unten). Sollte sich dieses Fenster nicht automatisch öffnen, klicken Sie 

mit der rechten Maustaste auf die Arbeitsfläche und wählen Sie Agent Properties aus. 

http://www.lotus.com/
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[Abbildung: Lotus Notes Agent] 

 

LotusScript anlegen 

Nachdem Sie den Agent angelegt haben, müssen Sie unter der Option Run die Auswahlbox auf LotusScript 

festlegen. In der ersten Zeile der Arbeitsoberfläche muss nun Option Public stehen. Wenn Sie einen leeren 

Agent erstellt bzw. aufgerufen haben, können Sie den LotusScript Code aus der Textdatei kopieren und 

komplett auf der Arbeitsoberfläche einfügen. Der Scripteditor fügt den Scriptcode nun an die richtigen Stellen 

im Editor ein. Dies sind standardmäßig die folgenden Anweisungen: 

 
 (Options) für das Hauptfenster 
 (Declarations) für die Deklaration der Variablen 
 Initialize steht für die Funktion Initialisierung des Agent 
 Terminate ist die Funktion für das Beenden des Agent 

 

Wenn Sie bereits ein Script erstellt haben und das Script erweitern möchten, so müssen Sie den Scriptcode 

an der jeweilige Stelle (Funktionen) einfügen. 

Agent bearbeiten 

Wenn Sie nachträglich einen Agent bearbeiten möchten, finden Sie unter dem Menüpunkt View > Agents 

eine Übersicht über alle angelegten Agents. Den jeweiligen Agent können Sie durch einen Doppelklick öffnen. 

Mailanbindung 

Lotus Notes - LotusScript  

Versenden einer eMail mit der eMail-Adresse aus dem combit Relationship Manager Datensatz (NotesMl.txt) 

 

Ablauf des Scripts: 

1. Starten des Agents in Lotus Notes. 
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2. Sie bekommen nun einen Dialog (siehe Abbildung 1), in dem Sie entweder für den aktuellen combit 
Relationship Manager Datensatz die eMail-Adresse übernehmen ('Ja'), oder aber über 'Nein' einen 
Dialog zur Auswahl des Datensatzes (siehe Abbildung 2). 

3. Wenn Sie nun in Lotus Notes zurückwechseln wurde ein neues Memofenster (Mail) mit der eMail-
Adresse des combit Relationship Managers erzeugt (siehe Abbildung 3). 

 

 

[Abbildung 1: Scriptauswahldialog] 

 

 

[Abbildung 2: Datensatz im combit Relationship Manager auswählen] 
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[Abbildung 3: Die erstellte eMail in Lotus Notes mit der combit Relationship Manager eMail-Adresse] 

combit Relationship Manager VBScript 

Sie können die Scripts über den Menüpunkt Extras > Scripts > Ausführen aufrufen oder in der Eingabemaske 

Ihrer Datenbank einen Scriptbutton platzieren. Die VBScripts mit der Endung .vbs finden Sie in der ZIP-Datei 

zu diesem Knowledgebase Artikel. Notwendige Anpassungen und ausführliche Beschreibungen zu den 

einzelnen Beispielscripts finden Sie in den Kopfzeilen eines Scripts. 

 
 Direktes Versenden einer Einzel-eMail für den aktuellen combit Relationship Manager Datensatz mit 

Lotus Notes (SndMail.vbs) 
 Direktes Versenden einer eMail für alle Datensätze der Datenbank oder des aktiven Extraktes mit 

Lotus Notes (SdMailAll.vbs) 

Kontakte/Adressen 

Lotus Notes – LotusScript 

 
 Exportiert alle Kontakte der aktiven Kontaktdatenbank von Lotus Notes in den combit Relationship 

Manager (Export_cRM.txt). Weitere Felder können wie folgt hinzugefügt oder geändert werden: 

 
oRecord.SetContentsByName "cRMFeldname",  Cstr(Doc.FirstName(0)) 

 
 Import aller Datensätze der aktuell geladenen combit Relationship Manager Datenbank in Lotus 

Notes (Import_cRM.txt). 
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Hinweis: Wenn ein Extrakt in der combit Relationship Manager Datenbank aktiv ist, werden alle Datensätze 

im Extrakt in Lotus Notes exportiert. 

 
 Erstellen eines neuen Lotus Notes Kontaktes anhand des aktuell geöffneten combit Relationship 

Manager Datensatzes. Die Feldnamen basieren auf dem mitgelieferten Solution Projekt und können 
von Ihnen leicht angepasst werden (oRecord.GetContentsByName("Vorname")). Die Lotus Notes 
Datenbank basiert auf dem Template des Personal Address Book (NewCon_cRM.txt). 

 
 Erstellen eines neuen combit Relationship Manager Datensatzes aus dem aktuell geöffneten Lotus 

Notes Kontakt. Die Feldnamen können für Ihre combit Relationship Manager bzw. Lotus Notes 
Datenbank/Dokument angepasst werden. (NewCon_cRM.txt). Dazu müssen Sie lediglich den 
Feldnamen ändern: 

 

oRecord.SetContentsByName "Vorname", Cstr(CurrentDoc.FieldGetText("FirstName")) 

Termine und Aufgaben 

Anbindungen von Terminen und Aufgaben können ebenfalls über die Lotus Notes OLE-Schnittstelle bzw. 

LotusScript realisiert werden. Sie können jedoch auch unter dem Menüpunkt Konfiguration > Allgemein > 

Termine & Aufgaben als Termin- und Aufgabenverwaltung IBM Lotus Notes auswählen. 

VBScript Beispiel zum Anlegen eines Termins in Lotus Notes 

 

' **************************************************************************** 

' Termin in Lotus Notes anlegen 

' ************************************************************************** 

' Lotus Notes Maildatenbank 

Const cNotesMailDB = "test.nsf" 

 

' Lotus Notes Objekt 

Dim oSession, oMaildb  

Set oSession = CreateObject("Notes.NotesSession") 

 

If cNotesMailDB <> "" Then 

 Set oMaildb = oSession.GETDATABASE("", CStr(cNotesMailDB)) 

Else 

 ' Standard Maildatenbank 

 Set oMaildb = session.GetDatabase( "", "" ) 

     Call oMaildb.OpenMail 

End If 

Dim oMailDoc 

Set oDoc = oMaildb.createdocument 

oDoc.form = "Appointment" 

oDoc.AppointmentType = "0" 

oDoc.subject = "Testtermin" 

oDoc.STARTDATETIME = CDate("29.05.2010 15:30:00") 

oDoc.ENDDATETIME = CDate("29.05.2010 17:30:00") 

oDoc.Chair = "CN=Test/O=Test" 
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oDoc.save False, False, False 

Weitere Anbindungen 

Gerne stehen Ihnen für weitere Anbindungsmöglichkeiten / Funktionalitäten von Lotus Notes mit dem combit 

Relationship Manager die combit Relationship Manager Solution Partner zur Verfügung. 

 
 http://www.combit.net/crm.aspx 

Anhang: Einbindung über ODBC  

Anzeigen von Lotus Notes Daten im cRM / Microsoft SQL Server 

Falls es notwendig sein sollte, Daten im combit Relationship Manager oder Daten aus dem combit 

Relationship Manager in Lotus Notes angezeigt zu bekommen, bietet Lotus Notes einen eigenen SQL Treiber 

an. Die Anbindung erfolgt hierbei per ODBC als externe Datenquelle. Eine externe Datenquelle kann über 

einen sog. "Verbindungsserver" in den Microsoft SQL Server eingebunden werden. Dieser ermöglicht dann 

den Zugriff auf fremde Datenquellen, in diesem Fall eine Lotus Notes Datenbank. 

 

Eine ausführliche Anleitung für die Konfiguration finden Sie in der bei dem Treiber mitinstallierten NotesSQL 

Hilfe. Bitte fragen Sie für die Konfiguration des Treiber Ihren zuständigen Lotus Notes / Domino 

Systemadministrator. 

 

Bitte beachten Sie, dass für die Verwendung einer SQL Sicht im combit Relationship Manager eine 

"Schemagebundene Sicht" verwendet werden muss. Eine ausführliche Anleitung mit einem Beispiel finden 

Sie im nachfolgenden Knowledgebase Artikel: 

 

Einbindung externer Datenquellen über MS SQL Server 
 http://www.combit.net/de/support/kb/search.asp?article=KBAD001072 

Lotus NotesSQL Driver for Notes 

Die aktuellen Treiber und die notwendigen Voraussetzungen finden Sie auf der Lotus Notes Homepage 
 NotesSQL Site (http://www.lotus.com/notessql) 

http://www.combit.net/crm.aspx
http://www.combit.net/de/support/kb/search.asp?article=KBAD001072
http://www.lotus.com/notessql

	Einleitung
	Integration von Kontaktmanagement und Kommunikationssoftware
	Aufgabenstellungen aus Anwendersicht
	Lösung durch Integration zweier leistungsfähiger Produkte

	Versenden von eMails
	Konfiguration der Schnittstellen
	Einrichtung im combit Relationship Manager
	Einrichtung von Lotus Notes als Standard eMail-Programm

	Bekannte Einschränkungen

	Import/Export von Adressen
	Import für Kontakte
	Export für Kontakte
	Zusatzprodukte zu Lotus Notes
	Anbieter von Zusatzprodukten


	Zugriff auf die Adressdaten per LDAP
	Einleitung
	Konfiguration in Lotus Notes
	Suche von Adressdaten

	Verfügbare programmierte Anbindungen
	Einleitung
	Was ist ein LotusScript Agent?
	Anlegen eines LotusScript Agent
	LotusScript anlegen
	Agent bearbeiten

	Mailanbindung
	Lotus Notes - LotusScript
	combit Relationship Manager VBScript

	Kontakte/Adressen
	Lotus Notes – LotusScript


	Termine und Aufgaben
	VBScript Beispiel zum Anlegen eines Termins in Lotus Notes

	Weitere Anbindungen
	Anhang: Einbindung über ODBC
	Anzeigen von Lotus Notes Daten im cRM / Microsoft SQL Server
	Lotus NotesSQL Driver for Notes



